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Chapter 1: Banner Introduction                                          
 

What is Banner? 
 
Banner is a Web-based, administrative software application developed specifically for higher education 
institutions by a company named Sungard Higher Education. 

 
Banner provides an online environment that allows users to perform administrative functions in a highly 
efficient manner. Data is entered into a database, and integrated and shared among different 
departments across the University. 
 

How to log in 
 

Banner is accessed via the Northeastern State University portal at http://go.nsuok.edu. 

 
1.  Using Internet Explorer, go to the Portal website. 

 
2.  Enter your same Username and Password that you use for GreenMail, click Login. 
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3.  On the Home Community tab, click the desired channel 

 

 
 

4. Once on the chosen channel, refer to the “Banner Links” box for access to Banner and Self-Service 
Banner. 
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Chapter 2: General menu and Navigation 

 
The Banner Main Menu will be displayed after successfully logging on to Banner.  The Main Menu 
provides an overview of the menus, forms, and jobs in Banner.  
 
Components of the Main Menu include: 

 Menu Bar 

 Tool Bar 

 Title Bar 

 Go To… field – Direct Access 

 Hierarchical menu 

 Auto Hint/ Status Line 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Auto Hint/ Status Line  
asdLineLine  LineLine 

Go To… 
field 

Hierarchical 
Menu 

Menu Bar 

 

Tool Bar 
BBarBarB
Bar 

Title Bar 
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Menu Bar 
 
The Banner Menu Bar, located at the top of every form, contains pull-down menus. It offers 
a variety of options for navigating within Banner. The Menu Bar is accessible anytime except 
when a dialog box, alert box, or list of values (LOV) is displayed on the screen. 
 
There are nine pull-down menus on the Menu Bar, each with a variety of selections.  

 
 
 
 

Tool Bar 
 
The Banner Tool Bar contains buttons that perform common functions. It is located directly 
under the Menu Bar. 
 

To access a Tool Bar button: 
 
Select the appropriate button. You can click a button any time, except when you are in a 
dialog box, alert box, or List of Values (LOV). (You must respond to these windows before you 
can select a button.) If a button is dimmed, then it is disabled and cannot be clicked. 

 

Title Bar 
 
The Title Bar of all Banner forms shows the description, form name, version number, and database: 
 
 
 
 
Bubble Help 

 
When you move your cursor over a button and pause, a tool tip appears with text that 
describes the function of the button. 
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Direct Access 

 
Direct Access is entering the name of the form (e.g., SPAIDEN, SAAADMS, TSAAREV) in the 
Go To… field of the Main Menu. When the Main Menu is open, your cursor focus will automatically 
be in the Go To… field. Simply type the name of the form and press ENTER on your keyboard.  
 

 
 
 

You can also access forms using Direct Access if you are not in the Main Menu. Choose File > 
Direct Access, then enter the name of the form, and press ENTER. You will be taken to the form 
you chose (if you have access to that form). 

Hierarchical Menu Tree Structure 

 
When accessing Forms from the Main Menu they are displayed as a hierarchy. You can expand and 
collapse content by clicking on the folders. 

 
Closed folder 

 
Select the closed folder to the left of an 
item to expand and view items contained 
under it. 

 
Open folder 

 
Select the open folder sign to collapse 
the menu into the original item. 

 

Last 10 Forms in the File Pull-Down Menu 
 
You can quickly re-access a form that was previously opened in the current session. The 
bottom of the File pull-down menu lists the last forms (up to ten) you used in the current session. You can 
re-access any form in the list. 
 
Note: 
The only forms that never appear in this list are the QuickFlow Form (GUAQFLW), Direct Access Form (GUAPARM), 
and Object Search Form (GUIOBJS).  
 
To access a form from the File pull-down menu: 
1. Access the File pull-down menu. 
2. Select the form name from the list at the bottom of the pull-down menu. 
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Auto Hint and Status Line 

 
 
 
 

 
Auto Hint 
The Auto Hint at the bottom of the form may contain the following information for the field where 
the cursor is located: 

 

 Brief field description 

 Error and processing messages 

 Keyboard shortcuts 

 Instructions for accessing other blocks, windows, or forms from the field 

 
Tip: If you have typed something that is not allowed in the field, read the message on the Auto Hint 
line.  To clear the message, select the Help button once; this will re-display the original information 
about that field. 
 

Status Line 
The Status Line directly under the Auto Hint can contain one or more of the following messages: 

 
 Record n/n: Shows the number of the current record followed by the total number of records in the 

current block.  If there are more records than fit in the window, the total appears as a question mark 
(for example, 3/?) until you scroll to the last record in the block.  Once the last record is displayed, 
the total appears as a number (for example,3/15). 

 List of Values: Indicates the field has a List of Values. 

 Enter-Query: Indicates the form is in query mode. 
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Site Map 
 
The Site Map provides an all-encompassing look at the Banner menus. 
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Chapter 3: Banner Forms 
 

Banner is composed of forms.  Forms are what might also be referred to as screens or windows.  Think 
of Banner forms as paper forms.  Each form represents a specific body of information, such as a name 
and address form or class schedule form.  

 
PLEASE NOTE:  YOU WILL ONLY SEE THE NAMES OF FORMS TO WHICH YOU HAVE ACCESS.  

 
Every form has a unique 7-character name (e.g., SPAIDEN) and a description of the form (e.g., 
General Person Identification Form).           For information about how Banner forms are named, see the 
appendix Banner Naming Conventions.  

 

Information in Banner forms, like paper forms, is arranged in blocks.  Understanding Banner 
navigation and the many functions a form has, will better help you in retrieving data. 

 
A form is an online document where you can enter and look up information in the database. A form 
visually organizes information so it is easier to enter and read. A Banner form is similar to a paper form, 
except information is entered once and then used by other forms, reports, and jobs. 

 
Forms can include windows, dialog boxes, and alert boxes. 

 
For example, in the picture below, the red box outlines the SPAIDEN form. 
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Parts of a Form 
 
A form is composed of multiple parts. Not all parts can be seen on all forms. These parts will be 
described below. 

 
 
 
 
 
 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

Item Description 

 

Title Bar 
May display the form’s descriptive name, the seven character ID 
name, the software version number and the database name. 

 

Key Block 
Contains information that determines what is entered or 
displayed on the remainder of the form. 

 

Information Block 
Displays data about the information entered in the Key Block. 
Area where you enter information prior to updating a record. 

 

Search Icon 
Calls up the set-up form that contains the pre-entered data for 
you to select an ID. 

 

Field 
Area on a form where you can enter, query, change, and display 
specific information. 
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Item Description 

 
Tabs 

Tabs are used to arrange information in a meaningful way, and allow 
you to navigate easily between groups or blocks of information. 

 

Radio 
button 

Used to select one of several options. Only one radio button can be 
selected at a time. 

Checkbox Used to enable or disable features or options. 

 
Pull-down 
list 

Used to select a field value from a list of pre-defined values. A 
down arrow in the right side of the field indicates that the field has a 
pull-down list. 

 

Blocks 
 
A block is a section of a form or window that contains related information. If a form or window contains 
more than one block, each block (except the key block) may be enclosed in a beveled box. 

 
Blocks: 

 Group information together 

 Can be one or more on a screen 

 May be organized on tabs within a form 

 Think of them as “sections” on a form 
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For example, a student’s record in SPAIDEN contains the following blocks: Current Identification (A), Person 
Name Information (B), and Non-Person Information (C). 

 

There are two types of blocks, a Key Block and an Information Block 

Key Block 
 

 The place you start on a form. 
 Every form has a Key Block. 
 A unique code is entered such as an ID number, term code or document number. 
 Lets Banner know what piece of information you want to retrieve. 
 The rest of the information on the form will refer to the information that you enter on the 

Key Block. 
 

Information Block 
 

 Section that contains related information to what was entered in the Key block. 
 A line may separate each Information block on the form. 

 

 
  



13 
 

 

 

Navigating Blocks 

 
To navigate in between blocks or tabs, you would use the Next Block or Previous Block functions. These are 
icons located on the Tool Bar in a form. If you prefer to use keystrokes for navigation, you can use Ctrl-Page 
Down to reach the Next Block or Ctrl-Page Up for the Previous Block. 
 

Next Block 
 
 

 

 

Previous Block 
 

 
 

Fields 
 
Fields are labeled space within a block. You can enter, query, change and/or display specific information 
within a field.  
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There is usually more than one field on a form. Below is an example of a form and some of its fields 
 have been marked as examples. 

 
 

 
Field States 

 
A field can be in one of two different states on a form: Enabled or Disabled. 
 

Enabled 

 Cursor is allowed in the field. 
 Information in the field is displayed in black text. 

 
Disabled 
 

 Cursor is not allowed in the field. 
 If information exists, it cannot be changed. 

 
NOTE: YOU MAY NOT BE ABLE TO NAVIGATE TO ALL FIELDS WITHIN A FORM. ON QUERY ONLY FORMS, YOU 

FREQUENTLY CANNOT MOVE THROUGH ANY FIELDS AT ALL. 
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Field Values 

 
Any data that is entered or displayed in a field is a value. There are two types of values as detailed in the 
chart below. 

 
NOTE: THE NAMES OF THE FIELDS THAT HAVE A PRE-DEFINED VALUE, OR LOV, HAVE A DROP DOWN ARROW NEXT 

TO THE FIELD. FIELDS THAT YOU CAN SEARCH FOR A VALUE IN THE DATABASE ALSO HAVE A DROP-DOWN ARROW 

NEXT TO THE FIELD. THE MOST COMMON EXAMPLE IS THE ID FIELD ON THE %IDEN FORMS.  

 
 
 
 
 

 
 

 
Type 

 
Description 

 
Example 

 
Free-format 

 
Free access to type in 
whatever information is 
required. 

 
Not previously defined on 
a validation form. 

 
Street addresses 

 
List of Values (LOV) 

 
Data on the LOV comes 
from previously defined 
values on a validation 
form. 

 
When you double-click on 
a LOV field. Use a Search 
icon or press the F9 key, 
previously defined values 
are displayed. 

 
State codes – FL, PA, 
DE 

 
Search Field 

 
If a field is a search field 
you must click the search 
icon to search. 

 
ID, Last Name, First 
Name 
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Navigating Fields 

 
To navigate between fields, use the next and previous field keystrokes as detailed below. 
 

Function Command 

Next Field Tab OR Enter 

Previous Field Shift + Tab 

 

NOTE: YOU MAY ALSO NAVIGATE BETWEEN FIELDS USING THE ITEM PULL-DOWN MENU ON THE MENU BAR. 
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Chapter 4: Searching                                                           
 

Search using a Wildcard 
 
A wildcard is a special character that represents one or more other characters. Use wildcard symbols % 
and _ in the search criteria. 
 

 % (percent sign) represents any number of characters 
 _ (underscore) represents one occurrence of a character 

 

NOTE: MA IS USED AS AN EXAMPLE. THE WILDCARD SYMBOLS CAN BE USED WITH ANY COMBINATION OF LETTERS 

IN ANY ORDER. 
 

To get these results... Enter these criteria... 
All entries that contain ma %ma% 
All entries that begin with ma ma% 
All entries that end with ma %ma 
All entries that have m as a second 
character 

 

_m% 

 

1.  Press Tab to place the cursor within the Name field. 

 
Type as much of the name as possible and then place % at the end to signal where you are unsure of the 
values. The screen shot below shows an example. 

 
Press Enter when you are ready to search. The ID and Name Extended Search window will appear. 
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2.  Click on the Search Results field drop down (A); the list of results will appear. 

 
If the Wildcard produced too many results for you to determine the correct user, additional search 
criteria may be entered into this window; see the screen shot below (B). 

 
After entering additional criteria, click the magnifying glass icon (C) to continue the search. The new 
results can be viewed within the Search Results drop down (A). 
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Object Search 
 
You can use Object Search to access a form if you know part of its name, description, or type. 

 
When you use Object Search from a form, the current form remains open. When you exit the requested 
object, you return to the original form. 
 
 

NOTE: YOU CANNOT SEARCH FOR AN OBJECT USING CODE/DESCRIPTION LOOKUP IN THIS FIELD. YOU CAN, 
HOWEVER, SEARCH BY SELECTING THE SEARCH BUTTON AND THEN PERFORMING YOUR SEARCH ON GUIOBJS. 
 
 

To use Object Search: 

 
1.  Double-click the Go To... field on the main menu OR Select File > Object Search from any form. 

 
NOTE: YOU CAN USE THE UP AND DOWN ARROW KEYS WITHIN THE GO TO FIELD TO SCROLL THROUGH FORMS 

THAT YOU HAVE PREVIOUSLY ACCESSED IN THE BANNER SESSION. PRESS ENTER TO GO TO THAT FORM. 

 
 
 
 

     OR  

 

 

 
 
 
 
 

The Object Search Form (GUIOBJS) will appear. 
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2.  Enter your search criteria on the Object Search form (A).  You can use any or all of the 
Name, Description, and Type fields. You can use the Oracle wildcards % and _. 

 
Select Query > Execute (also known as Execute Query) (B). A list of all matches will appear. 
 
 

 
 

 
 

 
 
 
3.  Find the desired name. You may need to use the scroll bar on the right side depending on list length. 

 
Double-click the desired name or click Start. The object selected will appear. 
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Querying the Database 
 

To look up information in a database, you perform a query.  In Banner, this is accomplished by entering 
the search criteria into a form and executing the query.  Inquiry and query forms are designed for this 
purpose, but you can also execute a query from most of the application forms. 
 

Wildcard Characters 
 
Wildcard characters can be useful when performing queries.  A wildcard is a special symbol that 
represents one or more characters. This enables you to enter search criteria in a query form without 
having to type the entire word or phrase you are searching for.  Wildcards will also allow you to find 
multiple records with a single query. 

 
Banner allows the use of two wildcard characters:  the percent sign (%) and the underscore (_).  The % 
represents any combination of characters.  The _ represents a single occurrence of any character. 
 

         To obtain these search results                        Enter this as your 
             search criteria 

All entries containing the characters ha                  %ha%  

Entries beginning with the characters ha               ha%  
Entries ending with ha                                               %ha  
Entries where h is the second character                _h% 

Query Functions 
 
The following functions are used to perform queries in Banner.  The Enter, Execute, and Cancel functions 
are available via icons on the Horizontal Tool Bar.  They are also available on the Query pull-down menu, 
along with the rest of the Query functions. 

 
Enter                  Erases any search results that may already be displayed in the form and allows 

you to “enter” your search criteria.  The phrase “Enter Query“ appears in the 
status line. 

 
Execute Used after you have entered your search criteria, this function searches the 

database and displays the results of the query. 
 

Last Criteria Causes the search criteria from your last search to be entered in the form.  
Any of the criteria can be changed prior to executing the query. 

 
Cancel Cancels the query if the form is in query mode or exits the form (if not in 

query mode). 
 

 
Count Hits Counts the number of records that will be returned by the search criteria.  

This number is displayed in the Auto Hint Line. 
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Fetch Next Set Replaces records currently displayed in the window with the next set of 
records that match the search criteria. 

Perform a Basic Query 
 

1.  Open the form you will use to execute the query. 

 
2. If the form opens in query mode (i.e., the form contains no search results, and the phrase “Enter 

Query” is displayed in the status line), go to step 3. 

 
If the form opens already displaying search results, click Query/Enter or the Enter Query button 
on the Horizontal Tool Bar. 

 
3. Input the search criteria.  It is possible to search for information in any field that you can access.  

It is unnecessary to type the complete search criteria if you use the Banner wildcard characters 
% and _.  Queries in Banner are usually case-sensitive, so enter your search criteria according to 
the way the data you are searching has been input. 
 

4. Click Query/Execute or the Execute Query button on the Horizontal Tool Bar.  All records that 
match the search criteria will be displayed on the form. 
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Multiple Methods to Perform Functions and Tasks 
 

A function or task is an activity performed on a Banner form.  There are a variety of different ways to 
perform functions or tasks:  click an icon/button, click a pull-down menu selection, or press a keystroke 
combination. 

 
The method used to perform actions in Banner is entirely up to the user. The correct keystroke 
combination will afford the same end result as clicking an iconic button or a pull-down menu.  While 
many functions or tasks can be accomplished with a choice of three techniques to perform them, not 
every action has all three choices (corresponding buttons, keystrokes, and pull-down menus). 
 

Keystrokes 

 
Keystrokes used to perform functions or tasks can be found by clicking 
Help/Show Keys or pressing Ctrl+F1 keys. 
 

 
Iconic Buttons 

 
In addition to the standard Windows response buttons (Yes, No, OK, Cancel, Exit, etc.), Banner utilizes 
iconic buttons that are unique to the Banner system. Iconic buttons are simply small squares that 
contain a picture (icon). These buttons are not displayed on the Horizontal Tool Bar.  They are displayed 
within the forms as you navigate through the Banner system. 
 

Iconic 

Button 
Function
/ Task 

 

Description 

 

 

Approve 
 

Indicate the process is approved. 

 

 

Disapprove 
 

Indicate the process is not approved. 

 

 

Calculate 
Perform a calculation on data in the current 
field. 

 

 

Calendar 
 

Open the Banner Calendar window. 
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Comments 
Open a freeform text box to enter comments 
regarding the current record. 

 

 

Complete 
 

Indicate the process is completed. 

 

 

In Process 
Indicate the process is started but not yet 
complete. 

 

 

Copy 
 

Copy the current record(s). 

 

 

Data 
Indicate that data is available for the 
current field. 

 

 

No Data 
Indicate that no data is available for the 
current field. 

 

 

Detail 
Display detailed information for the current 
record. 

 

 

Summary 
Display summary information for the current 
record. 

 

 

Maintenance 
 

Update information in the database. 

 

 
Search 

Display a query form or window that allows 
a search for information associated with the 
current field. 
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Features Distinctive to Banner 
 

List of Values (LOV) 

 
As you create or modify records in the Banner database, you will encounter fields that accept only 
specific codes or values.  These fields display a Search button (     ) immediately to the right.  
The Search button is an indicator that the field may have an associated List of Values (LOV).  The 
LOV for the field contains all possible values that are acceptable for the field.  These values are 
stored in a Banner Validation form, and the entire LOV can be viewed by clicking the Search button 
or double-clicking in the field box itself. 

 
To input the correct value in a field controlled by a LOV, use one of the following methods: 

 
 Type the value or code in the field box, if known. 

 
 Type as much as you know of the desired value and use the Banner wildcard characters % 

or _ to search for the code. 

 
 Click the Search button (    ) next to the field or double-click in the field box to view 

the entire LOV.  Scroll through the LOV to find and select the desired value. 
 

QuickFlows 

 
QuickFlow is the Banner term that refers to a group of forms linked together in a chain.  Linking 
forms allows the user to be automatically directed to the next form in the chain once they have 
finished with the previous form.  This ensures that no steps are missed in a process, and eliminates 
the need for the user to remember which form should be used in what order. 

 
QuickFlow, like other Banner forms, have a short name (usually 3-4 characters) and a Description.  
To start a QuickFlow, the short name can be entered in the Direct Access box on the General 
Menu.  If the short name is not known, use Object Search to locate the QuickFlow with a partial 
short name or Description, combined with the Banner wildcard character (%).  To see a list of all 
QuickFlow, go the QuickFlow Form (GUAQFLW) form and click the search button to view the list. 
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Rollback 

 
Rollback clears all information displayed in the information block and allows you to return to the 
Key Block.  Once in the Key Block, you are able to search for and select a different record to work 
with or display in the form. 
 

The Rollback button (      ) is available on the Horizontal Tool Bar, or you may click Rollback on 
any Options window or the File pull-down menu. If modifications to data have not been saved 
prior to returning to the Key Block, Banner will prompt you to save your changes. 
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APPENDIX A 
 

 

 

Form Naming Conventions 
 
Banner forms, reports, jobs, and tables are given long descriptive names and short 7-character names.  
Knowing how to decipher the 7-character name can tell you a lot about the purpose of a form.  The 
naming conventions for the Banner products purchased by NSU are included in this appendix:  Student, 
Finance, Human Resources, Financial Aid, and General. 
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Student 
 

Position 1 
Identifies the primary 
system that owns the form, 
report, job, or table. 

S     Student 

 
 

 
 
 
 
 
 
 

 
 
 
 
 
   

 
 

 

 

 

 

 

 

 

 

 

 

 

EXAMPLES: 
 

Form 
Name 

 

S 
 

P 
 

A 
 

I 
 

D 
 

E 
 

N 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

S            Student     S            Student 
P            Person     H           Grades/Academic History 

A           Application    R           Report 
IDEN     Identification    ROLL    Grade Roll 
 
Description:  General Person Identification Form Description:  Grade Roll to Academic History Report 
 
 

 
 

  

Position 2 
Identifies the module within the 
primary system that owns the 
form, report, job, or table. 

A Admissions 

C Catalog 

E Support Services 

F Registration/Fee Assessment 

G General Student 

H Grades/Academic History 

I Faculty Load 

L Location Management 

M CAPP 

O Overall 

P Person 

R Recruiting 

S Schedule 

T Validation Form/Table 

U Utility 

W 
Y 
Z 

Reserved for client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y, 
Z.) 

Position 3 
Identifies the type of form, 
report, job, or table. 

A Application Form 

B Base Table 

I Inquiry Form 

P Process 

Q Query Form 

R Rule Table 

Repeating Table 

Report or Process 

V Validation Form/Table 

View 

Positions 4, 5, 6, 7 
identifies unique, four 
 character name for the 
form, report, job, or table. 

Form 
Name 

 

S 
 

H 
 

R 
 

R 
 

O 
 

L 
 

L 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
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Finance 
 

 

Position 1 
Identifies the primary system 
that owns the form, report, 
job, or table. 

F Finance 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EXAMPLES: 
 

Form 
Name F O I D O C H 

Letter 

Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

F            Finance      F            Finance 
O           Operations     G           General Ledger 
I             Inquiry      R           Report 

DOCH   Document History     ACTH    Account Hierarchy 
 
Description:  Document History Form   Description:  Account Hierarchy Report 
 
 
 

 

Position 2 
Identifies the module within 
the primary system that owns 
the form, report, job, or table. 

A Accounts Payable 

B Budget Development 

C Cost Accounting 

E Electronic Data Interchange 

F Fixed Assets 

G General Ledger 

I Investment Management 

N Endowment Management 

O Operations 

P Purchasing/Procurement 

R Research Accounting 

S Stores Inventory 

T Validation Form/Table 

U Utilities 

X Archive/Purge 

W 
Y 
Z 

Reserved for client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y,Z.) 

Position 3 
Identifies the type of form, 
report, job, or table. 

A Application Form 

B Base Table 

I Inquiry Form 

M Maintenance Form 

Q Query Form 

R Rule Table 

Repeating Table 

Report or Process 

V Validation Form/Table 

View 

Form 
Name F G R A C T H 

Letter 

Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 

Positions 4, 5, 6 , 7, 
Identifies a unique, four 
character name for the job, or 
table. 
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Human Resources 
 

Position 1 

Identifies the primary system that 
owns the form, report, job, or table. 

N Position Control 

P Human Resources/ 
Payroll/ Personnel 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EXAMPLES: 
 
 

Form 
Name P H R D I R D 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

P            Personnel     N           Position Control 
H           Time Reporting/History    B           Budget 

R           Report      A           Application 
DIRD     Direct Deposit     POSN    Position Definition 
 
Description:  Direct Deposit Distribution Report  Description:  Position Definition Form 
 

Position 2 
Identifies the module within 
the primary system that owns 
the form, report, job, or table. 

A Application 

B Budget 

C COBRA 

D Benefits/Deductions 

E Employee 

H Time Reporting/History 

O Overall 

P General Person 

R Electronic Approvals 

S Security 

T Table (Validation or Rule) 

U Utility 

X Tax Administration 

W 
Y 
Z 

Reserved for client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y, 
Z.) 

Position 3 
Identifies the type of form, report, 
job, or table. 

A Application Form 

B Base Table 

Batch COBOL Process 

I Inquiry Form 

P Process 

R Rule Table 

Repeating Table 

Report or Process 

V Validation Form/Table 

Form 

Name N B A P O S N 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 

Positions 4, 5, 6 , 7, 
Identifies a unique, four 
character name for the job, or 
table. 
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Financial Aid 
 

 

 

 
  
 

 

 

 

 

 

 

 

 

 

 

 

EXAMPLES: 
 

Form 

Name R O A I N S T 

Letter 

Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

R           Financial Aid      R           Financial Aid 
O           Common Functions      T            Table 
A           Application      V            Validation 

INST     Institutional Options     AWST   Award Status 
 
Description:  Institution Financial Aid Options Form   Description:  Award Status Validation Form 
 
 
 

 

Position 2 
Identifies the module within 
the primary system that owns 
the form, report, job, or table. 

B Budgeting 

C Record Creation 

E Electronic Data Exchange 

F Funds Management 

H History and Transcripts 

J Student Employment 

L Logging 

N Need Analysis 

O Common Functions 

P Packaging and 
Disbursements 

R Requirements Tracking 

S Student System Shared 
Data 

T Validation Form/Table 

U Utility 

W 
Y 
Z 

Reserved for client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y,Z.) 

Position 1 

Identifies the primary system that 
owns the form, report, job, or 
table. 

R Financial Aid 

Position 3 
Identifies the type of form, 
report, job, or table. 

A Application Form 

B Base Table 

I Inquiry Form 

P Process/Report 

R Rule Form 

Repeating Rules Table 

Report 

T Temporary Table 

V Validation Form/Table 

View 

Form 

Name R T V A W S T 

Letter 

Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 

Positions 4, 5, 6 , 7, 
Identifies a unique, four 
character name for the job, or 
table. 
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Advancement 
 

Position 1 
Identifies the primary 
system that owns the form, 
report, job, or table. 

A    Advancement 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
   

 
 

 

 

 

 

 

 

 

 

 

 

 

EXAMPLES: 
 

Form 
Name 

 

A 
 

P 
 

A 
 

I 
 

D 
 

E 
 

N 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

A            Advancement    A            Advancement 
P            Person     G Gift & Gift/Pledge Payment 

A           Application    P Process/Report            
IDEN     Identification    ACKN    Acknowledgement Process 
 
Description:  General Person Identification Form Description:  Acknowledgement Process 
 
 

 
 
 
 
 
 

Position 2 
Identifies the module within the 
primary system that owns the 
form, report, job, or table. 

A Membership 

D Designation 

E Event Management 

F Campaign 

G Pledge & Gift/Pledge Payment 

L Label 

M Prospect Management 

O Organization 

P Constituent/Person 

S Solicitor Organization 

T Validation Form/Table 

U Utility 

X Expected Matching Gift 

W 
Y 
Z 

Reserved for client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y, 
Z.) 

Position 3 
Identifies the type of form, 
report, job, or table. 

A Application Form 

B Base Table 

C Called/ List Form 

I Inquiry Form 

P Process/Report 

Q Query Form 

R Repeating Rules Table 

T Temporary Table 

V Validation Form or View 

  

Positions 4, 5, 6, 7 
identifies unique, four 
character name for the form, 
report, job, or table. 

Form 
Name 

 

A 
 

G 
 

P 
 

A 
 

C 
 

K 
 

N 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
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General 
 
 

Position 1 
Identifies the primary system 
that owns the form, report, job, 
or table. 

G     General 

 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 
 

 
 
 
 
 
EXAMPLES: 

 
Form 
Name G U A U P R F 

Letter 

Position 
 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 
 

G           General     G           General 
U           Utility     T            Validation Form/Table 
A           Application    V            Validation Form/ Table 
UPRF    User Preferences    CURR    Currency 

   

Description:  General User Preferences  Description:  Currency Codes Validation Table 
Maintenance Form 

 

 

 

Position 3 

Identifies the type of form, report, 
job, or table. 

A Application Form 

 
B 

Base Table 

Batch COBOL Process 

I Inquiry Form 

O On-Line COBOL Process 

Q Query Form 

 
R 

Rule Table 

Repeating Table 

Report or Process 

 
T 

General Maintenance 

Temporary Table 

 
V 

Validation Form/Table 

View 

Position 2 

Identifies the module within the 
primary system that owns the 
form, report, job, or table. 

E Event Management 

J Job Submission 

L Letter Generation 

O Overall 

P Purge 

S Security 

T Validation Form/Table 

U Utility 

X Cross Product 
 
 
Sadf 
Asdf 

 

 
W 
Y 
Z 
 

 
Reserved for 
client- 
developed forms or 
modules. (Character in 
position 1 not = W, Y,Z.) 
 

Form 

Name G T V C U R R 

Letter 
Position 

 

1 
 

2 
 

3 
 

4 
 

5 
 

6 
 

7 

Positions 4, 5, 6, 7, 
Identifies a unique, four 
character name for the job, or 
table. 
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Help and Online Assistance 
 
There are various types of assistance available: 

 Auto Hint (mentioned previously) 

 Help Center 

 Online Help 

 
 

Help Center 
 
The Help Center is electronic documentation delivered by SunGard Higher Ed and is 
available for many forms. Please note that this documentation is baseline, which means that if NSU 
modified a form, this will not be reflected in the documentation. Also note that if online help exists for a form, 
there will be no information for that form in the Banner documentation. 
 
To access the Help Center, click Help Center next to the Site Map button at the top-right hand 
side of the screen. For assistance, please send an e-mail to help@nsuok.edu. 

 
Online Help 
 
The Online Help system is the online information for Banner forms, windows, blocks, 
and fields. You can access Online Help by choosing Help from the Main Menu and then selecting Online Help 
from the drop-down menu that appears. 
 

 
Help icon               You can use the Online Help Tool Bar icon to access online help. 

 

 
 

 
Help Center link   

 
You can access online help from the Banner main menu by clicking the 

Help Center link. 
 

 
  

 
 

mailto:help@nsuok.edu
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Using Help 
 
Help menu The Help pull-down menu contains the various help options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 

Option  Purpose 

Online Help  Displays online information for the current field or form. 

Dynamic Help Query  Displays the Dynamic Help Form (GUAHELP) in query mode, which is used to 
display traditional help for a field, block, or form. 

Dynamic Help  Edit Displays the Dynamic Help Form (GUAHELP) in edit mode, which is used 
to edit traditional help for a field, block, or form. 

 Banner Bookshelf Provides electronic access to hardcopy  Banner documents directly from 
your computer. 

Help (Item Properties)  Displays the Oracle item properties window for the current field. 

Show Keys Displays the Keys list, which lists the functions and their equivalent 
keystrokes available in your environment for the current form, window, and 
field. 

List  Displays the List of Values (LOV) for the current field if List of Values appears 
in the status line. 

Display Error  If an Oracle error occurs, displays the code that is in error. 

Display ID Image If the cursor is in an ID field, displays the image associated with the ID, if 
available. 
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 Option  Purpose 

Calendar Displays the Calendar Form (GUACALN), showing a calendar with the current 
month open by default. 

Calculator Accesses the Calculator Form (GUACALC), which functions as a 
calculator. You can use the mouse, number keys on the keyboard, or the 
numeric keypad to make calculations. 

Extract Data with Key Extracts  Banner data for the current block, with key data, to a spreadsheet. 

Extract Data No Key Extracts  Banner data for the current block, without key data, to a 
spreadsheet. 

Technical Support Contains three sub-menu options. The first two options allow you to turn the 
SQL Trace feature on and off. SQL Trace is a tool that helps your technical 
support staff track performance issues. The last option allows you to 
reconnect to the database if necessary. 

About  Banner Displays a list of installed  Banner products, their release number, and their 
installation date. This information will be helpful if you need to contact the 
ActionLine with a question. 
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Banner Navigation Short Cut Keys 
 
There are numerous keyboard short cuts available in BANNER. The specific keystrokes for a 

function depend on your environment.  The Show Keys command in the Help Menu lists the 

keyboard equivalents available in your environment for the current form, window and field.  In 

addition, the Alt  key gives quick access to the Menu Bar items. 

 
 
 
 
 
 

Menu Bar: 

 

Alt+E  Alt+B  Alt+R  Alt+T 
 
 
 
 
Alt+F  Alt+O  Alt+I  Alt+Q  Alt+H 

 
 
 
 
 
 

Rollback 

Tool Bar (or Icon bar): 
 

Previous 

 
 
Enter 

 
Cancel 

Query 

Broadcast 

Message 

 
Multi- 

Institution 

Supplemental 

Data Engine 

Insert 
Record 

Record Previous 
Block 

Query  Print Functionality 

 
 

 
Save  

Select 
 
Remove 

Record 

 
 

Next 

Record 

 
Next 

Block 

Execute 

Query 

Banner 

Message 

Xtender  
Fine- 

Grained 

Access

Online 

Help 
Exit
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Banner Shortcut Keys 

Function  Shortcut Key Function  Shortcut Key 

File Save                 F10 
File Rollback            Shift + F7 

File Exit                    Ctrl + Q 

 
Query Enter             F7 

Query Execute        F8 

Query Cancel  Ctrl + Q Query 
Count Hits  Shift + F2 

 
Record Next      ↓ or PageDn Record 

Previous          ↑ or PageUp Record 

InsertF6 

Record Duplicate     F4 
Record Clear           Shift + F4 

Record Remove  Shift + F6 

 (delete) 

 
Select Record          Shift + F3 

Block Next                Ctrl + PageDn 

Block Previous          Ctrl + PageUp 

Block Clear              Shift + F5 

 
List of Values  F9 
Display Error  Shift + F1 

Show Keys  Ctrl + F1 

Print Screen  Shift + F8 

 
Field Next  Tab 

Field Previous  Shift + Tab Field 

Clear  Ctrl + U Field 

Duplicate  F3 

 
Save  F10 

Rollback  Shift + F7 

 
Options Menu  Right Click or F2 
Direct Access bar  F5 
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Appendix B 
 

Banner General Rules for Clean and Accurate Records 
 

 Search first.  Before creating a new record for a person or organization, conduct an 
identification and name search to make sure the person or organization has not already been entered 
into the Banner system.  Search for a person or vendor using social security number or federal ID 
number, birth date (if available), and all current and previous names.  Then verify that the correct record 
has been found by checking pertinent information such as the birth date and/or address.  Only if no 
record is found should you add a new record.  
 Changes may impact other modules.  A common institutional database offers the potential for 

better service and convenience to our constituents and greater accuracy across the institution.  
Simultaneously, each administrative position must be cognizant of data integrity requirements of other 
institutional departments in its practices.  Name change practices are a key example where specific 
policies must be followed depending on the type of record.  Whenever a constituent requests a name 
change it is necessary to determine in which modules the record occurs.  

 Special symbols.  Never store the percent symbol (%) in a data field.  Never store the 
ampersand symbol (&) except in an address or business name.  In addition, avoid the use of other 
special symbols such as #, @, *, _, /, “, =, >, and < whenever possible as these may interfere with 
programs running behind the scenes. 

 Check abbreviations.  Spell out all data unless it is necessary to abbreviate words to fit lines into 
the appropriate fields.  Exceptions are made for items in addresses, such as directionals (NE, SW) and 
street suffixes (St for Street, Ave for Avenue).  When abbreviating, use the standard abbreviations as 
specified in the Data Standards Manual.  DO NOT use a period after an abbreviation. 
 Use mixed case.  Enter all data using mixed case and standard capitalization rules.  Names and 

addresses in Banner should have a customer-friendly appearance.  The objective is to enter names and 
addresses with mixed case (both upper and lowercase letters) so that when a name or address is printed 
on correspondence, it looks contemporary and professional.  
 Data entry rules.  Remember that some data fields have specific data entry rules.  Those rules 

are outlined in the appropriate section of the Data Standards Manual. 
 Refer to the Data Standards Manual for detailed information about Addresses in NSU’s Banner 

system. 
 
General Information about Names 
 
 A person’s legal name appears on official documents such as a birth certificate, court order, 

social security card, marriage license or passport. The Office of Admissions uses the name reported on 

an application as the legal name.   Human Resources Office requires official documents.  

 Name formats have also been developed to meet postal regulations. It is recommended that 

offices that collect person names on applications, or any other types of forms, designate separate 

fields on the form for that person to indicate first name, middle name and last name. This will 

facilitate our ability to enter a name correctly into the respective fields in Banner.  

 
 
 
 The following forms are used to enter and change name information. The form used depends 
upon the Banner module in use:  
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FORM NAME   BANNER MODULE 
SPAIDEN  STUDENT, FINANCIAL AID 
PPAIDEN  HUMAN RESOURCES 
FTMVEND   FINANCE (‘non-person’ vendors) 
FOAIDEN   FINANCE (‘person’ vendors) 
APAIDEN            ALUMNI/DEVELOPMENT 

 
 Last Name, First Name and Middle Name appear on all of the above forms.  First Name and Last 

Name are required fields in Banner.  Although Middle Name is not required in Banner, middle name 

should be entered for reporting purposes. 

▬ Person Last Name – maximum length 60 characters  
▬ Person First Name – maximum length 60 characters  
▬ Person Middle Name – maximum length 60 characters  
▬ Non-Person Name – maximum length 60 characters 
▬ Prefix, Suffix and Preferred First Name appear only on SPAIDEN, PPAIDEN and                                    

APAIDEN.  
 
 
General Information about Addresses 
 
 Street addresses are composed of a number, the street name and a possible unit designator. 

Street names should be spelled out in their entirety whenever possible.  Street designators should 

follow the standard US Post Office standards.  

 The USPS prefers use of pre-direction and post-direction abbreviations without a period.  These 

describe the geographic direction before and after the street name.  Directionals should be spelled 

out only when they are part of the street name. (ex: 123 E North St) 

 Always abbreviate Post Office Box as PO Box. 

 Zip or postal codes MUST be entered for all US and Canadian addresses. If available, it should 

also be entered for other international addresses.  For all US addresses, enter the five-digit zip code 

before entering the city, county, or state.  If the zip code is entered correctly the city, county, and 

state are automatically displayed in the appropriate fields.  This not only eliminates the need to key 

this information, but also ensures that it is correct.  Note that you must enter the five-digit zip code 

only, then press the ENTER key (or the TAB key), which will cause Banner to fill in the city, county, and 

state.  You can then return to the zip code to add the remaining digits for a nine-digit zip code.  If you 

are entering a vendor or employee, you MUST enter a nine-digit zip code. 

 Punctuation (periods, commas and apostrophes) should not be used.  Use hyphens and slashes 

in addresses when needed for clarity or designated fractions. 
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